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The steps for connecting the antennae to your card vary
slightly depending on the type of computer you have:
compact (with a built-in monitor), modular, or tower.

A1

After the card is installed, you are ready to connect an FM
antenna and a TV antenna (or cable service connection) to
your card.

m If you purchased the Apple TV/FM Radio System kit
separately from your computer, before you read this manual
be sure to install the card following the instructions in the
Apple TV/FM Radio System Installation Manual (the other
manual in your kit).

m If you purchased the computer with the TV/FM tuner card
already installed, you are ready to read the information in
this manual.

The TV/FM tuner card should already be installed in your
computer.

Before you start

Connecting Antennas, Cable,
and Other Video Equipment
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icon.

FM antenna

Attach the FM antenna to the FM tuner port.
The FM tuner port is marked with the icon.

the left, marked by the

Chapter 1

2 Attach the provided FM antenna to the FM port—the port on

Choose Shut Down from the Special menu. Then press the
power switch (marked with the j symbol) at the back of
your computer.

1 Turn off the computer if it isn’t already off.

To attach FM and TV connections to the card, follow these
steps.

After installing the TV/FM tuner card by attaching the card to
the computer, you then attach an FM antenna and a TV
antenna (or cable service connection) to the card.

If you have a compact computer

icon,
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Coaxial cable connector
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Important Do not attach or detach the coaxial cable while
the computer is turned on.

Coaxial cable from an external TV antenna or cable TV service

Attach the coaxial cable to the TV tuner port.
The TV tuner port is marked with the icon.

to a cable service or to a TV antenna.

3 Connect the TV port on the right, marked by the
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FM antenna
(Attach the “T” in the position
that gives clearest reception.)

Chapter 1

Attach the antenna to a wall in the position that gives the
clearest reception. Use tape, thumbtacks (anywhere through
the middle of the plastic strips), or pushpins (through the
white plastic ends).

best reception.

4 Unfold the FM antenna and position it high in a “T” for the

Connecting Antennas, Cable, and Other Video Equipment

and go on to “Connecting Other Video Equipment.”
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5 Skip the next two sections about other types of computers,
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FM antenna

the left, marked by the

icon.

Chapter 1

Attach the FM antenna
to the FM tuner port. The
FM tuner port is marked
with the icon.

2 Attach the provided FM antenna to the FM port—the port on

Choose Shut Down from the Special menu.

1 Turn off the computer if it isn’t already off.

To attach FM and TV connections to the card, follow these
steps.

After installing the TV/FM tuner card by attaching the card to
the computer, you then attach an FM antenna and a TV
antenna (or cable service connection) to the card.

If you have a modular computer

icon,
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Coaxial cable connector
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Important Do not attach or detach the coaxial cable while
the computer is turned on.

Coaxial cable from an external TV antenna or cable TV service

Attach the coaxial cable
to the TV tuner port. The
TV tuner port is marked
with the icon.

to a cable service or to an antenna.

3 Connect the TV port on the right, marked by the

A8

go on to “Connecting Other Video Equipment.”

Chapter 1

5 Skip the next section, “If You Have a Tower Computer,” and

FM antenna
(Attach the “T” in the position
that gives clearest reception.)

Attach the antenna to a wall in the position that gives the
clearest reception. Use tape, thumbtacks (anywhere through
the middle of the plastic strips), or pushpins (through the
white plastic ends).

reception.

4 Unfold the FM antenna and position it high for the best

icon.
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FM antenna

Attach the FM antenna to the FM tuner port.
The FM tuner port is marked with the icon.

the left, marked by the
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2 Attach the provided FM antenna to the FM port—the port on

Choose Shut Down from the Special menu.

1 Turn off the computer if it isn’t already off.

To attach FM and TV connections to the card, follow these
steps.

After installing the TV/FM tuner card by attaching the card to
the computer, you then attach an FM antenna and a TV
antenna (or cable service connection) to the card.

If you have a tower computer

icon,

A10

Coaxial cable connector

Important

Chapter 1

Do not attach or detach the coaxial cable while
the computer is turned on.

Coaxial cable from an
external TV antenna
or cable TV service

Attach the coaxial cable to the TV tuner port.
The TV tuner port is marked with the icon.

to a cable service or to an antenna.

3 Connect the TV port on the right, marked by the

Connecting Antennas, Cable, and Other Video Equipment

FM antenna
(Attach the “T” in the position
that gives clearest reception.)
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Attach the antenna to a wall in the position that gives the
clearest reception. Use tape, thumbtacks (anywhere through
the middle of the plastic strips), or pushpins (through the
white plastic ends).

reception.

4 Unfold the FM antenna and position it high for the best
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m you determine which type of video connector you need for
your video equipment (see the next section)

m you place the video equipment near enough to your
Macintosh for easy connection

m both the Macintosh and the video equipment are turned off

Before you start, make sure that

Preparing to connect video equipment

Note

You can also connect two pieces of video equipment
to the video input card simultaneously—one to the S-video
input port on the card and another to the composite video
input port on the card. For example, you can view a
recording from a video camera connected to the S-video port,
then switch—using the Apple Video Player application,
without having to disconnect cables—to viewing video from a
VCR connected to the composite port on the card. However,
you will hear sound only from that piece of equipment that is
connected to the audio input ports on the card.

You can connect one piece of equipment to the S-video
port or one piece to the composite video port on the video
input card.

If you want to see video on your computer from a VCR,
laserdisc player, video camera, or other video equipment,
you need to connect the equipment to the ports on the
video input card in your computer.

Connecting other video equipment

Composite video port (RCA-type)

Connecting Antennas, Cable, and Other Video Equipment

S-video connector
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To connect to an S-video video out port, use an S-video
connector. See “Connecting Video Equipment If You Use an
S-video Connector.”

Composite connector (RCA plug)

To connect to a composite video out port, use a composite
(RCA plug) connector. See “Connecting Video Equipment If
You Use a Composite (RCA Plug) Video Connector.”

S-video port

Check the video out port or ports on your video equipment.
A video out port should look like one of the ports pictured
below. (You may have both ports.)

Determining which video connector
you need

audio

RCA

2 audio

video

2 audio

RCA

RCA

RCA

RCA

RCA

RCA
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Note

Chapter 1

If you have only one audio out port on your video
equipment, you can use a Y-adapter audio cable. This cable
has a single plug on one end to plug into your equipment
and a double plug (where it forms a Y) on the other end to
plug into the two audio ports on the video input card.

RCA

or

RCA

RCA
video

audio

RCA

or

video

RCA

To connect your video equipment you need one video cable
and two audio cables, all with RCA plugs at both ends. The
cables can be separate or joined. You can purchase cables at
electronics supply stores.

Connecting video equipment if you use
a composite (RCA plug) video connector

Connecting Antennas, Cable, and Other Video Equipment
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If you’re using a Y-adapter audio cable: Plug the double
end of the cable (where it forms a Y) into the right and left
sound input ports on the video input card.

Be sure to plug the cable from the left audio out port on the
video equipment to the left sound input port on the
computer. Connect the right ports in the same way.

into the left (white) and right (red) sound input ports on the
video input card.

5 Insert the RCA plugs on the other end of the audio cables

If you’re using a Y-adapter audio cable: Plug the single
end of the cable into the audio out port on your video
equipment.

4 Insert the RCA plugs on one end of the audio cables into the
left and right audio out ports on the video equipment.

composite video input port on the video input card.

3 Plug the other end of the video cable into the yellow

the video equipment.

2 Attach one end of the video cable to the video out port on

are turned off.

1 Make sure that both the Macintosh and the video equipment

Right audio out port

Left audio out port

Video out port
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Your video equipment is now connected to the video
input card.

The ports on your video equipment may be arranged
and labeled differently from those shown here.

Cables with
RCA plugs

Right sound input port (red)

Left sound input port (white)

Video input port (yellow)

Chapter 1

The illustration below shows a modular computer, but the
video input card ports are similar on a computer with a builtin monitor or a tower computer.

RCA

S-video

Connecting Antennas, Cable, and Other Video Equipment
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If you have only one audio out port on your video
equipment, you can use a Y-adapter audio cable. This cable
has a single plug on one end to plug into your equipment
and a double plug (where it forms a Y) on the other end to
plug into the two audio ports on the video input card.
Note

RCA

S-video

2 audio

audio

RCA

or

RCA

audio

RCA

RCA

S-video

S-video

To connect your video equipment you need one video cable
with S-video connectors on both ends and two audio cables
with RCA plugs at both ends. The RCA cables can be separate
or joined. You can purchase cables at electronics supply
stores.

Connecting video equipment if you use an
S-video connector
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If you’re using a Y-adapter cable: Plug the double end of
it (where it forms a Y) into the right and left sound input
ports on the video input card.

Be sure to plug the cable from the left audio out port on the
video equipment to the left sound input port on the
computer. Connect the right ports in the same way.

into the left (white) and right (red) sound input ports on the
video input card.

5 Insert the RCA plugs on the other end of the audio cables

If you’re using a Y-adapter audio cable: Plug the single
end of the cable into the audio out port on your video
equipment.

4 Insert the RCA plugs on one end of the audio cables into the
left and right audio out ports on the video equipment.

If the connector doesn’t slide easily into the port, realign it
and try again. Avoid using force, which could damage the
card or the connector.

About the S-video port: The S-video port accepts 4-pin and
7-pin connectors.

port on the video input card.

3 Plug the other end of the video cable into the S-video input

the video equipment.

2 Attach one end of the video cable to the video out port on

are turned off.

1 Make sure that both the Macintosh and the video equipment

Right audio out port

Connecting Antennas, Cable, and Other Video Equipment
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The ports on
your video
equipment may
be arranged
and labeled
differently from
those shown here.

Left audio out port

Your video equipment is now connected to the video
input card.

Cables with
RCA plugs

S-video cable

S-video port (4-pin)

S-video port (7-pin)

Left sound input port (white)

Right sound input port (red)

The illustration below shows a modular computer, but the
video input card ports are similar on a computer with a builtin monitor or a tower computer.
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m To learn how to capture individual images or whole movie
sequences, see Chapter 7, “Capturing TV or Video Images.”

m To customize TV tuner features in the way that best fits your
viewing habits, see Chapter 6, “Customizing the TV Tuner
Settings.”

m To begin watching TV or video immediately, turn to
Chapter 5, “Watching TV or Video.”

If you want to watch TV or video

m To learn how to save radio recordings on your computer,
see Chapter 4, “Recording from the Radio.”

m To preset your favorite stations or to set the radio to receive
only the strongest station signals, see Chapter 3,
“Customizing the FM Radio Settings.”

m To begin listening to the radio immediately, turn to
Chapter 2, “Listening to the FM Radio.”

If you want to listen to the radio

The TV/FM tuner card is preset to display TV shows from
broadcast TV and to play FM radio broadcasts.

Where to go from here
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See also: Chapter 9, “Using the Remote Control.”
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You may find listening to the radio more convenient if you
first set up some of the options discussed in Chapter 3,
“Customizing the FM Radio Settings.”

This chapter contains most of the information you need to
use the Apple FM Radio application program to listen to FM
radio on your computer.

Listening to the FM Radio

C
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Note

Chapter 2

If you get a message telling you to select TV as the
video source in Apple Video Player, do that. If you need
help, see “Choosing a Video Source” in Chapter 5.

If you do not hear the radio right away, see the section
“Problems Listening to the Radio,” in Chapter 10.

Listening to the FM Radio
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To see explanations of all the items on the screen when you
use Apple FM Radio, make sure that the FM Radio window is
active, then choose Show Balloons from the Guide (h)
menu.

Note

When the Apple FM Radio application opens, a window
appears and the radio comes on. (You may hear only static
until you tune in a clear station.)

Note

Apple FM Radio Guide is not available if you have a
computer with system software earlier than 7.5.

If while using the Apple FM Radio application you become
stuck or forget how to do a task, on-screen help may be
available. Make sure that the FM Radio window is active,
then open the Guide menu (marked with the h icon) and
choose Apple FM Radio Guide.

Getting help

You turn off the Apple FM radio by quitting the application.

Turning off the FM radio

If you can’t find the Apple FM Radio application on
your computer’s hard disk, see the section on reinstalling
the software in Chapter 10, “Troubleshooting.”

To turn on the Apple FM Radio application, open it by
double-clicking its icon. (The application is in the Apple FM
Radio folder, in the Apple Extras folder on your hard disk.)

Turning on the FM radio
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To automatically assign the clearest stations to the Preset
Station buttons, see “Presetting Stations Automatically” in
“Presetting Stations,” in Chapter 3.

Note

The FM tuner is preset to search all stations for the
clearest signals. However, you can set the tuner so that it
searches for clear stations within a certain signal range or
strength. For example, you can preset the tuner to scan only
local signals or to scan all but the weakest signals. See
“Setting Signal Range and Strength” in Chapter 3.

To tune in to only the clearest stations, click the Up or Down
arrows under Seek. The FM radio stops at each of the
clearest stations it receives.

Seeking stations

To learn how to assign preset stations, see “Presetting
Stations” in Chapter 3.

You can tune in to stations with the Apple FM Radio
application much as you would with any radio—by pressing
one of the tuning arrows or one of the six Preset Station
buttons on the left (after you have assigned stations to
them). The frequency number of the station you are playing
is displayed.

Tuning in to stations

Listening to the FM Radio

m Use the volume controls on the remote control. See
Chapter 9, “Using the Remote Control.”
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m Press the Up Arrow key or Down Arrow key on the keyboard.

m Drag the slider next to the speaker icon on the FM Radio
window. (You can also click anywhere in the slider’s track to
move the slider to that position.)

m Use the volume buttons on the front of the computer.

There are four ways to change the volume.

Changing the sound’s volume

You can adjust the FM radio’s volume and set the radio to
receive stereophonic (stereo) or monophonic (mono)
sound. The sound adjustments you make take effect
immediately, so you can monitor your changes.

Adjusting the sound

To tune in to all available stations (whether or not they come
in clearly), click the Up or Down arrows under Step. To cycle
through the stations more rapidly, place the pointer on one
of the arrows and hold down the mouse button.

Stepping through all stations
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The chosen sound mode has a checkmark beside it.

mono sound.

Chapter 2

2 Choose Stereo to receive stereo sound or Mono to receive

A pop-up menu appears beside the Sound choice.

1 Open the Options menu and drag to the Sound choice.

Apple FM Radio is preset to play sound in stereophonic
(stereo) sound if the station broadcasts in stereo. Some
stations come in more clearly if you select monophonic
(mono) sound. To select stereo or mono sound, follow
these steps.

Selecting stereo or mono sound
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Customizing is optional: The information and instructions
provided in this chapter are meant to make using your Apple
FM Radio application more convenient. You don’t have to
customize the Apple FM Radio application to listen to the
radio on your computer. For the basic information you need
about listening to the radio, read Chapter 2.

You’ll need to turn on the radio before following the
instructions in this chapter. To turn on the radio, open the
Apple FM Radio application program by double-clicking its
icon. (The application is in the Apple FM Radio folder, in the
Apple Extras folder on your hard disk.)

This chapter explains how to use the Apple FM Radio
application program to give names to stations, to preset
stations you want to listen to most frequently, and to set the
signal range and strength of the stations you want to receive.

Customizing the
FM Radio Settings

C
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m Press one of the buttons in the Preset Stations window
(chosen through the Options menu).

m Choose a preset station from the pop-up menu next to the
frequency of the current station in the FM Radio window.
The pop-up menu lists preset stations in numerical order for
easier reference.

m Press a Preset Station button in the FM Radio window.

After you assign preset stations, there are three ways you can
tune them in:

Tuning in to preset stations

This section describes how to preset stations so you can
tune them in quickly.

Presetting stations

Customizing the FM Radio Settings
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m Place the pointer on the station’s frequency, drag it from
the box onto one of the six Preset Station buttons, then
release the mouse button. (Note: This method works only
if you have system software version 7.5 or later.)

m Place the pointer on a Preset Station button, then hold
down the mouse button until you hear a beeping sound.
The current station’s frequency appears on the button.

button:

2 Use one of the following methods to assign the station to a

The station is displayed in the lower-left corner of the FM
Radio window.

Stations” in Chapter 2.)

1 Tune in to the station you want to preset. (See “Tuning in to

To specify your favorite station as a preset station, follow
these steps:

Assigning stations to the Preset Station
buttons

A30

Note

Chapter 3

The first six rows in the Preset Stations window
represent the six buttons in the FM Radio window.

This method lets you preset more than six stations.

m Open the Options menu and choose Add Preset Stations.
When the Preset Stations window appears, move it away
from the FM Radio window so that you can see both of them
clearly. Place the pointer on the station’s frequency and
drag it from the box onto one of the rows in the Preset
Stations window. When the row highlights, release the
mouse button.

Customizing the FM Radio Settings

If you want to make changes to the preset buttons, see
“Changing Preset Stations” later in this section.
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station’s frequency in the FM Radio window) to see the list
of all stations you have preset. You can use this menu to
choose a preset station to listen to.

3 Click on the pop-up menu (the arrow next to the current

Note

If you just type the station’s name and not the
frequency, the station won’t be assigned as a preset station.
You must type in the frequency because the frequency is
what the FM tuner uses to find the station.

You can also type in the station’s name and your own
description, although they’re not required. To display this
information on the Preset Station buttons, see “Labeling
Preset Station Buttons” later in this section.

m In the Preset Stations window, type in the frequency of the
station you want assigned to that row.

A32
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If you’ve preset stations already, they appear in the rows.

The Preset Stations window appears.

1 Open the Options menu and choose Add Preset Stations.

To preset the clearest stations by adding them automatically,
follow these steps.

Note

The Apple FM Radio application is set to search all
stations for the clearest signals when automatically adding
stations. You may want to search for stations within a certain
signal range or strength. If you want to do this, see the
section “Setting Signal Range and Strength” later in this
chapter before you continue with these instructions.

When you preset stations automatically, the Apple FM Radio
application automatically assigns the clearest stations to the
first available rows in the Preset Stations window, after
stations that have already been assigned. (The added
stations also appear in the pop-up menu list in the FM Radio
window.)

Presetting stations automatically

Customizing the FM Radio Settings

the stations in the Preset Stations window.

A33

1 Make sure that you have typed in names or descriptions for

To display names, descriptions, or numbers on the Preset
Station buttons, follow these steps:

The Apple FM Radio application automatically displays
stations’ frequencies on the six main Preset Station buttons
when you assign stations to them. But you can also display
stations’ names or descriptions on the buttons (or display
simply the numbers 1 through 6 on them).

Labeling Preset Station buttons

If you want to make changes to any of your preset stations,
see “Changing Preset Stations” later in this section.

The FM tuner adds the clearest stations to the rows in the
Preset Stations window and to the pop-up menu in the FM
Radio window. If you’ve preset some stations already, Auto
Add adds to the list in the Preset Stations window; it does
not override stations you have already preset. The stations
added appear in numerical order after the stations that were
already preset.

2 Click Auto Add.
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m Descriptions—if you want your own description of the
station to appear on the preset buttons. (Only the first four
to six characters of the description appear on the button.)

m Names—if you want the stations’ names to appear on the
preset buttons.
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m To undo all changes you just made to the Preset Stations
window (since you last opened it), click Revert.

m Frequencies—if you want station frequencies (for example,
102.1) to appear on the preset buttons.

Customizing the FM Radio Settings

m To clear a row (delete its contents), click anywhere in the
row and then click Clear Row.

m Numbers—if you want the preset buttons to be numbered in
order, 1 through 6.

following:

m To move a preset station to a different button or place in the
list, drag an entire row on top of another row in the Preset
Stations window.

m To add the current station to the list, drag its frequency onto
any button in the FM Radio window or to a row in the Preset
Stations window.

Remember: You must type in the frequency because the
frequency is what the FM tuner uses to find the station. You
can also change the call letters and description.

m To change a station in the Preset Stations list, click in the
frequency column of the row you want to change, and type a
new frequency label.

There are several ways to change the stations you’ve preset.

Changing preset stations

3 In “Type of Info Shown,” click in the circle next to one of the

2 Open the Options menu and choose Preferences.
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A checkmark appears beside the range that is selected.

Choose Local to receive only local stations.

2 Choose DX to receive any station the radio can pick up.

1 Open the Options menu and choose Signal Range.

To choose the range of the signals in which the FM radio
searches, follow these steps:

You can select the area—wide or local—from which Apple
FM Radio receives stations. The Apple FM Radio is preset to
receive whatever stations it can pick up, but you may
sometimes want to choose a local range to reduce
interference from strong neighboring stations (stations that
are not local).

Choosing signal range

You can set your FM radio so that it searches within a certain
signal range or strength for the clearest signals whenever
you use the Seek or Auto Add features.

Setting signal range and strength

Customizing the FM Radio Settings
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Besides selecting the type of station information you want to
have appear on the Preset Station buttons, you can also
choose the color in which the currently playing station’s
frequency is displayed, and whether or not you hear an alert
sound as a confirmation when you preset a new station.

Setting other preferences

The signal strength you choose affects how many stations
come up when you use the Seek or Auto Add features.

2 Select the signal strength you want.

1 Open the Options menu and choose Signal Strength.

To choose the signal strength that the Apple FM Radio looks
for when it seeks or adds stations, follow these steps:

By choosing a signal strength, you can set the Apple FM
Radio to seek or automatically add stations that send signals
of a certain strength. For example, if you set the signal
strength to Strongest Only, the Apple FM Radio will seek or
automatically add fewer stations than if you had set the
signal strength to All Stations.

Choosing signal strength

A38

Chapter 3

m To undo any changes you made since you last opened the
Preferences window, click Reset.

After you’ve finished selecting your preferences, click OK to
implement the changes. (The window then closes.)

m To turn off the beep you hear when a new station is
successfully preset, click in the Audio Confirmation of
Presets box to remove the X.

Note

Whatever station is currently playing is always
displayed in red in the Preset Stations window. The color
you choose only changes the frequency of the current
station displayed at the lower left in the FM Radio window.

m To change the color of text displaying the frequency of the
current station, open the Options menu and choose
Preferences. Click on the pop-up menu next to Color of
Current Station Text and select the color you want.

To learn how to change the compression/sample rate of any
recordings you make, see the section “Compressing
Recordings” in Chapter 4, “Recording from the Radio.”
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You’ll need to turn on the radio before following the
instructions in this chapter. To turn on the radio, open the
Apple FM Radio application program by double-clicking its
icon. (The application is in the Apple FM Radio folder, in the
Apple Extras folder on your hard disk.)

This chapter gives instructions for using the Apple FM Radio
application to record from the FM radio onto your
computer’s hard disk. It also gives instructions for
compressing recordings so that they take up less disk space.
You can play back recordings with the SimpleText
application, which uses QuickTime technology to play back
sound.

Recording from the Radio

C
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The FM Radio Preferences dialog box appears.

1 Open the Options menu and choose Preferences.

Chapter 4

To compress recordings, follow these steps before you
record:

Before you record, you may want to choose a compression
rate for your recording. Recordings that are not compressed
have high-quality sound, but they take up a lot of disk space.
If you compress a recording, you use less disk space but get
a lower-quality sound when you play it back (the recording
sounds less clear).

Compressing recordings

Recording from the Radio
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The compression rate you just chose remains in effect for all
recordings until you change the compression rate in the
FM Radio Preferences window again.

3 Click OK.

Note

The compression ratios possible for your computer
may be different from those possible for other computers.
(You may not be able to move the slider to certain positions
on the slider bar.)

You can also click anywhere in the track to move the slider.

Remember: Compression affects the sound quality of your
recording: the more compression you use, the less clear
your recording sounds.

A compression rate of 1:1 means that no compression takes
place. A compression rate of 3:1 uses a third of the disk
space that 1:1 uses. A compression rate of 6:1 saves the most
disk space.

compression rate you want by dragging the slider towards
“Least disk space” or “Highest Quality.”

2 In the Compression/Sample Rate box, choose the
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Immediately, the Record button turns into a Stop button and
red light, and a “Recording time” counter appears that tells
you the length of time that has passed since you clicked
Record.

2 Click the Record button in the FM Radio window.

See the previous section, “Compressing Recordings.”

you want to and haven’t done so already.

1 Be sure to choose a compression rate for your recording, if

To record from the radio and save it on a disk, follow these
steps.

You can record from the radio any time by pressing the
Record button in the FM Radio window.

Saving recordings

Recording from the Radio
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When you open the recording later (by double-clicking its
icon), it opens as a SimpleText document, which uses
QuickTime technology to play back the sound at the volume
level at which you saved it.

5 Click Save.

You can also play back a recording and adjust the recording’s
volume before you save it, using the Playback bar. Click the
play (.) button to play it back and the sound (-) button to
adjust the volume.

you want to save it.

4 Specify a name for your recording and the location where

The Save Audio Recording dialog box appears.

Important If you don’t click the Stop button, recording
continues until the hard disk is full.

3 Click Stop when you want to stop recording.
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See also: “Viewing the Teletext Window” in Chapter 8 and
Chapter 9, “Using the Remote Control.”

You may find watching TV more convenient if you first set
up some of the options discussed in Chapter 6,
“Customizing the TV Tuner Settings.”

This chapter contains most of the information you need to
use the Apple Video Player application program to watch TV
on your computer. You also use Apple Video Player to watch
video (from a VCR or video camera, for example) on your
computer.

Watching TV or Video

C
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If you see this message, click OK and go to the next section,
“Setting Up Your TV Channels.”

The first time you open the Apple Video Player application, a
message appears asking you to set up your TV channels.

Note

If you can’t find the Apple Video Player application on
your computer’s hard disk, see the section on reinstalling
Apple Video Player in Chapter 10, “Troubleshooting.”

To use the Apple Video Player application program, open it
by double-clicking its icon. (The application is in the Apple
Video Player folder, in the Apple Extras folder on your hard
disk.) You can also press the TV/MAC button on the remote
control.

Opening Apple Video Player

Watching TV or Video
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If you’ve set up your TV channels and still don’t get an image
in the window right away, see Chapter 10,
“Troubleshooting.”

If your TV channels are already set up, a video window
appears. You can watch video or TV in the video window.

A48

Note
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The Channel Setup dialog box will already be open if
you are setting up channels for the first time.

1 Choose Channel Setup from the Setup menu.

Apple Video Player can program your channel list to include
all valid channel frequencies from the available signal
sources (off air and cable). To have Apple Video Player set
up your TV channels automatically, follow these steps:

Auto tuning the channel list

Important

If you want to use Apple Video Player to
automatically tune (“auto tune”) your TV channel list, do so
before you add or remove channels manually. If you auto
tune after you manually add or remove channels, your
manual changes will be undone.

You must have at least one TV channel set up for viewing, or
else a reminder message will be displayed.

m You can have Apple Video Player automatically assign any
valid frequencies to your channel list, and then you can add
or remove additional channels manually.

m You can set up your channel list manually.

m You can have Apple Video Player automatically assign any
valid frequencies to your channel list.

There are three ways to set up your TV channel list:

You can set up your TV channel list to contain channels for
any frequency picked up by your antenna (off air) or cable
service connection.

Setting up your TV channels

Watching TV or Video
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If the Channel Setup dialog box is already open, the Setup
menu is dimmed and unavailable.

1 Choose Channel Setup from the Setup menu.

To add or edit channels manually, follow these steps:

In addition to adding channels to your TV channel list, you
can change existing channel settings by assigning the
channel a frequency and a name.

Adding to or editing the channel list

Although Auto Tune filters out channels that don’t send valid
signals, it doesn’t remove duplicate channels or channels
that send valid but scrambled signals (for example, pay-perview or premium cable channels to which you don’t
subscribe). Additionally, there may be channels in your
viewing area that you would simply prefer not to see when
you browse through the channels. For these reasons, you
may want to edit your channel list after you’ve used Auto
Tune. You can add channels that you didn’t want removed,
or remove channels that you don’t want to keep.

Scanning can take up to 30 seconds depending on the
number of channels available. Valid signals are assigned to
the channel numbers in your channel list, from low to high
frequencies. The rest are “disabled” and appear in the
channel list with a dash (-) next to them.

Note

Pressing the x key plus a period (.) cancels
Auto Tune.

2 Click Auto Tune.
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If you use an antenna to receive the frequency you are about
to set up, choose Off Air. If you use a cable service to receive
the frequency, choose Cable.

3 Click Off Air or Cable.

The Edit Channel dialog box for that channel appears.

m To edit a channel, select a channel that has either a name or
channel frequency already assigned to it.

m To add a new channel, select a channel that has a dash
beside it.

double-click the channel number or name in the channel list.

2 Select a channel in the TV channel list, then click Edit. Or,

Watching TV or Video
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The channels you’ve set up are available in the channel name
pop-up menu under the channel controls in the video
window.

7 Click OK to close the Channel Setup dialog box.

The channels you’ve added or changed are listed in the
channel list.

6 Click OK to close the Edit Channel dialog box.

See the section “Giving Names to Channels” in Chapter 6 for
more information.

Note

A channel must be assigned a name. If not, a message
appears reminding you of this.

5 Type a name for the channel in the Name box.

4 Select a channel frequency from the Channel pop-up menu.
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Once a channel is removed, it is replaced by a dash (-) in the
channel list.

To select several channels in a row to remove, hold down
the Shift key and drag. To select channels throughout the
list, hold down the Shift key and click each channel.

click Remove.

2 Select the channel or channels you want to remove, then

If the Channel Setup dialog box is already open, the Setup
menu is dimmed and unavailable.

1 Choose Channel Setup from the Setup menu.

To remove channels manually from the TV channel list,
follow these steps:

Removing channels from the channel list

Watching TV or Video

Note
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Apple Video Player Guide is not available if you have a
computer with system software earlier than 7.5.

On-screen help for the Apple Video Player application is
available through the Guide menu at the upper-right corner
of the screen, marked with the h icon. When Apple Video
Player is the active application, choose Apple Video Player
Guide from the Guide (h) menu. Apple Video Player Guide
gives you step-by-step instructions for tasks you need help
doing.

Getting help

Mono Sound: If a channel’s sound fades in and out, you
should set your TV to receive only mono sound for that
channel. See “Setting Channels to Monophonic Sound” in
Chapter 6.

Fine tuning: If after setting up you find that you’re unhappy
with the reception quality of some channels, you can try to
improve the reception by adjusting the tuner manually. See
“Fine Tuning your Channels” in Chapter 6.

Locking channels: You may want to keep a channel in the
channel list but restrict access to it. See both “Locking and
Unlocking Channels” and “Creating and Changing a
Password” in Chapter 6.
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To be reminded of keyboard shortcuts you can use with
Apple Video Player, choose Apple Video Player Shortcuts
from the h menu.

To see explanations of all the items on the screen when you
use Apple Video Player, make sure that Apple Video Player is
active, then choose Show Balloons.

Watching TV or Video

2 Click the video screen icon.

The Controls window appears.

Window.

1 Open the Windows menu and choose Show Controls

To choose a video source, follow these instructions:
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Using the Apple Video Player application, you can view TV
signals that come through a cable or an antenna, or watch a
video recording from a VCR or other video device.

Choosing a video source

You can also open the Apple Video Player application by
pressing a “hot key” (a preset key or combination of keys).
When you press this hot key, you switch to the Apple Video
Player program no matter what computer program you
are currently in. To learn how to set a hot key, see “Setting a
Hot Key” in Chapter 6.

Using a hot key
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The source change takes effect as soon as you make your
choice.

Note

If you’re not sure which port a video device is
attached to, see “Determining Which Video Connector You
Need” in the section “Connecting Other Video Equipment”
in Chapter 1.

m If you want to view video from a VCR or other device
that’s attached to the S-video input port, click S-Video.

m If you want to view video from a VCR or other device
that’s attached to the composite video input port, click
Video.

m If you want to watch TV, click TV.

3 Click the video source you want to use:

The screen controls appear.

Watching TV or Video
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Too many channels? When you browse through channels
using the remote control or the arrows on your keyboard or
video window, you may see channels that have no picture or
that show only static. To skip such channels entirely, see
“Removing Channels from the Channel List” in the section
“Setting Up Your TV Channels” earlier in this chapter.

Each time the channel changes, the channel name (if one
exists) appears briefly on top of the TV picture.

To go back and forth between the current channel and the
last one to which you were tuned, press the Tab key.

When you use an arrow, you go to the next available
unlocked channel (a channel with unrestricted access). To
go to a locked (restricted access) channel, you must enter a
channel number.

m Type the channel number.

m Use the channel controls on the remote control. For more
information, see Chapter 9, “Using the Remote Control.”

m Press the Left Arrow key or Right Arrow key on the keyboard.
(Make sure Apple Video Player is the active application, or
these keys won’t have any effect.)

m Select a name from the Names pop-up menu on the video
window (if you’ve given names to channels, as will be
discussed in Chapter 6).

m Click the Up or Down arrow on the video window.

When the video source is set to TV and the video window is
active, you can use any of the following methods to change
channels:

Changing TV channels
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Some TV programs offer you a choice of two languages that
you can listen to. These are called Dual Language programs.

Choosing a language

You can also click anywhere in a slider’s track to move the
slider to that position. The sound adjustments take effect
immediately, so you can monitor your changes.

To mute the sound, click the speaker on the video window,
press x-M on the keyboard, or press the muting button on
the remote control. To turn the sound back on, click the
speaker, press x-M, or press the remote control’s muting
button. The sound will also go back on if you adjust the
volume using any method.

m Use the volume controls on the remote control. For more
information, see Chapter 9, “Using the Remote Control.”

m Press the Up Arrow key or Down Arrow key on the keyboard.
(Make sure Apple Video Player is the active application, or
these keys won’t have any effect.)

m Drag the slider next to the speaker icon on the video
window.

m Use the volume buttons on the front of the computer.

There are four ways to change sound volume:

Changing the sound volume

You can adjust the sound’s volume, balance, and tone. You
can also choose monophonic (mono) or stereophonic
(stereo) sound.

Adjusting the sound

Watching TV or Video
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The new setting takes effect immediately (if it’s available).

3 Click the language you want to listen to (Language A or B).

The sound controls appear.

2 Click the sound icon.

The Controls window appears.

1 Choose Show Controls Window from the Windows menu.

To set the language mode, first make sure the video source
is set to TV, then follow these steps:

Language choices generally include your country’s native
language (Language A), and English (Language B), or two
native languages.
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Note
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You’ll only be able to hear changes in balance if
you’re using external speakers or headphones.

You can also click anywhere in a slider’s track to move the
slider to that position. The sound adjustments take effect as
you make them, so you can monitor your changes.

liking.

3 Drag the appropriate slider to adjust the sound to your

2 Click the sound icon.

1 Choose Show Controls Window from the Windows menu.

To adjust the speaker balance, bass, or treble:

Adjusting speaker balance and tone

Watching TV or Video
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You can also click anywhere in a slider’s track to move the
slider to that position. The picture adjustments take effect as
you make them, so you can monitor your changes.

liking.

3 Drag the appropriate slider to adjust the picture to your

The screen controls appear.

2 Click the video screen icon.

The Controls window appears.

1 Choose Show Controls Window from the Windows menu.

To adjust the brightness, sharpness, and tint of the picture:

Adjusting the picture
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Customizing is optional: The information and instructions
provided in this chapter are meant to make using your TV
tuner more convenient. You don’t have to customize the
TV tuner to watch television on your computer. For the basic
information you need about watching TV or video, read
Chapter 5.

Before following the instructions in this chapter you need to
open the Apple Video Player application by double-clicking
its icon. (The application is in the Apple Video Player folder,
in the Apple Extras folder on your hard disk.) You can also
press the TV/MAC button on the remote control.

This chapter explains how to use the Apple Video Player
application program to give names to channels, protect
channels with a password, and set reminders that notify you
when important shows are about to begin.

Customizing the
TV Tuner Settings

C

A64

Chapter 6

To remove a name from the channel, press the Delete key
while the entire name is highlighted.

3 Type a name for the channel.

The Edit Channel dialog box appears, with any name already
assigned to the channel selected. (Initially, channels have no
names assigned to them.)

2 Select a channel in the TV channel list, then click Edit.

1 Choose Channel Setup from the Setup menu.

Follow these steps to name or rename channels.

Channel names appear in the Names pop-up menu of the
video window. See “Changing TV Channels” in Chapter 5 for
information on using a name to select a channel.

You can assign a name of up to 15 characters to a channel.
The name can be the station’s call letters, network affiliation,
network name, or anything else you want.

Giving names to channels

Customizing the TV Tuner Settings

The Edit Channel dialog box for that channel appears.

2 Select a channel in the TV channel list, then click Edit.

1 Choose Channel Setup from the Setup menu.
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If you’re unhappy with the reception quality of a channel,
you can try to improve the reception by fine tuning the
channel manually. First make sure your video source is set to
TV, then follow these steps:

Fine tuning your channels

The name you typed appears to the right of the channel
number in the channel list.

4 Click OK.
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6 Click OK to close the Channel Setup dialog box.

5 Click OK to close the Edit Channel dialog box.

channel reception.

Chapter 6

4 Drag the Fine Tune slider to either side to change the

If you do not see the More Choices button, then the Fine
Tune slider should already be visible.

3 Click More Choices.

Customizing the TV Tuner Settings
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If you do not see the More Choices button, then the “Always
use mono sound” checkbox should already be visible.

3 Click More Choices.

The Edit Channel dialog box for that channel appears.

2 Select a channel in the TV channel list, then click Edit.

1 Choose Channel Setup from the Setup menu.

You can set your TV tuner so a channel receives only
monophonic (mono) sound (if stereo is not available, then
the sound setting will automatically default to mono). If a
station signal is weak, setting the sound to mono will
prevent the sound from fading in and out. First make sure
your video source is set to TV, then follow these steps:

Setting channels to monophonic sound
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You may have to scroll to see all possible choices.
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To select several channels in a row, hold down the Shift key
and drag. To select channels scattered throughout the list,
hold down the Shift key and click each of the channels you
want to lock.

3 Select the channels you want to lock by highlighting them.

Note

You can lock or unlock channels only in the channel
list for the connection that’s currently chosen. For example,
if you lock channel 15 in the antenna channel list, the
channel will not lock either in the cable channel list or in the
HRC cable channel list unless you name it in those lists, too.

for the channel list you want.

2 Choose from the Connection pop-up menu the connection

1 Choose Channel Setup from the Setup menu.

Locked channels appear in the channel list but don’t appear
in the video window when you scan through the channels.

Locking and unlocking channels

6 Click OK to close the Channel Setup dialog box.

5 Click OK to close the Edit Channel dialog box.

“X” appears).

4 Check the box next to “Always use mono sound” (so that an

Customizing the TV Tuner Settings
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To unlock a channel, choose Channel Setup from the Setup
menu, select the channel, and click Unlock.

If you click Yes and no password is in effect, you tune in to
that channel. However, the channel remains locked and out
of the normal scanning sequence. If a password has been set,
you must type the password before the channel can become
available.

You can watch a locked channel by typing its number on the
keyboard. A dialog box appears:

The channels you selected are locked. Small locks appear at
the left of the locked channels’ numbers in the channel list.

4 Click Lock.
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A dialog box appears.

1 Choose Set Channel Password from the Setup menu.

Follow these steps to create a password:

Creating a password

The same password applies to all locked channels.

Chapter 6

You can create a password to limit access to the Channel
Setup dialog box and locked channels. When you set a
password, anyone choosing Channel Setup from the Setup
menu or switching to a locked channel must type the
password.

Creating and changing a password

Customizing the TV Tuner Settings

A71

Important Make sure you keep a record of your password.
If you forget your password, you will have to reset all your
customized settings (including channel names and
programmed channels) when you invalidate it, as described
in “Forgetting a Password,” later in this section.

Your password is now in effect.

3 Click OK.

If you don’t want to have a clue, don’t type one.

You can also type a clue to help you remember the
password. The clue appears every time anyone seeking
access is asked for the password.

2 Type a word or phrase of up to 15 characters.
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Your new password is now in effect.
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To remove the password, make sure that the password in
the Password text box is selected (highlighted). Then press
the Delete key before you click OK.

box and click OK.

3 Type a new password in the Set Channel Password dialog

As you type, the characters are replaced by bullets to ensure
privacy.

If you’ve forgotten your password, see “Forgetting a
Password,” next.

2 Type the current password and click OK.

A dialog box appears.

Customizing the TV Tuner Settings
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Important When you move the Apple Video Player Prefs
file to the Trash, any preferences you have set (for example,
picture contrast or channel names) are changed back to the
standard settings provided by the Apple Video Player
application.

To reset the password, quit the Apple Video Player
application. Then move the Apple Video Player Prefs file to
the Trash. The Apple Video Player Prefs file is in the
Preferences folder, which is in the System Folder.

If you can’t remember your password, you must reset the
password and then create a new one.

If you enter an incorrect password, you see this dialog box:

Follow these steps to change a password:

1 Choose Set Channel Password from the Setup menu.

Forgetting a password

Changing a password
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The TV Reminders dialog box appears.
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The notice can appear up to 99 minutes before show time.

the number of minutes before the show starts that you want
a warning; then click the “Warn me” checkbox to select it.

7 If you want an advance notice before the show begins, type

If you select One Time Only, the reminder will be removed
automatically after the show airs.

basis or just once.

6 Specify whether the reminder should occur on an ongoing

If the channel has a name, you can select the name in the
pop-up menu to the right of the Channel number box.

To set a reminder, follow these steps:

1 Choose TV Reminders from the Setup menu.

box.

5 Set the channel by typing its number in the Channel number

4 Set the day and time that the show begins.

the notice.

3 Type the show’s name as you want it to appear in

The Edit Reminder dialog box appears.

2 Click Add.

Setting a reminder

If you click OK in this notice, the Apple Video Player
application opens, switches to the proper channel, and
displays the show in the video window.

The notice appears no matter which application you are
using on your computer at the notification time.

When the time you’ve set for a reminder arrives, a notice
appears on the screen.

You can arrange to have notices appear on your screen to
remind you that specific shows are about to begin.

Setting and editing TV reminders
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4 Click OK to close the TV Reminders dialog box.

The entry is removed immediately.

3 Click Remove.

Important

Chapter 6

There is no Undo function for the Remove
command. To restore an entry that you have removed, you
must reenter all the settings you made in the Edit Reminder
dialog box.

2 Select the entry you want to remove.

The TV Reminders dialog box appears.

1 Choose TV Reminders from the Setup menu.

To remove a reminder, follow these steps:

Removing a reminder

The changes you’ve made take effect immediately.

3 Make the changes you want to, then click OK.

The Edit Reminder dialog box appears.

Or, you can double-click the reminder.

2 Select the reminder you want to edit, then click Edit.

Customizing the TV Tuner Settings
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If you find that your hot key replaces a keyboard shortcut
in another program, repeat these steps to choose another
hot key.

Your new hot key is ready to use.

3 Click OK.

Don’t use a key combination that is already used by other
programs. For example, don’t use x-P, which is for printing
in most programs.

You can use one or more (up to four) of the modifier keys—
x, Option, Control, and Shift—plus any other key.

hot key.

2 Press the key or key combination you want to use for your

The Hot Key dialog box appears.

1 Choose Hot Key from the Setup menu.

To set a hot key, follow these instructions:

The TV Reminders dialog box appears.

1 Choose TV Reminders from the Setup menu.

To edit a reminder, follow these steps:

Editing a reminder

You can turn on the Apple Video Player application by
pressing a “hot key” (a preset key or combination of keys).
When you press this hot key, you switch to the Apple Video
Player application no matter what application you are
currently in. If the Apple Video Player is already the active
application, you can press the hot key to quit it.

Setting a hot key

You’ll return to the TV Reminders dialog box, where you’ll
see your new entry in the list.

8 Click OK.
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Before following the instructions in this chapter you need to
open the Apple Video Player application by double-clicking
its icon. (The application is in the Apple Video Player folder,
in the Apple Extras folder on your hard disk.) You can also
press the TV/MAC button on the remote control.

The images in the video window can come from the TV
tuner or from video equipment connected to your video
input card.

m sequences of moving images (as QuickTime movies)

m individual (still) images

This chapter gives instructions for using the Apple Video
Player application program to capture

Capturing TV or Video Images

C
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The capture controls appear.

2 Click the video camera icon.

The Controls window appears.

Chapter 7

1 Choose Show Controls Window from the Windows menu.

Follow these steps:

When you use the capture controls in the Controls window,
you can freeze the screen image before you save it.
Additionally, the capture controls let you save the image
directly on a disk.

Capture controls

You have two ways to capture a single image—by using the
capture controls in the Controls window or by using the
Copy Video Display command in the Edit menu.

Capturing individual images

Capturing TV or Video Images
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Important When you use Copy Video Display or press
x-C, the current screen image is copied to the Clipboard.
The image is not saved on a disk. (To save an image that’s
on the Clipboard, you must paste it into a document or the
Scrapbook.)

To capture the current screen image by copying, choose
Copy Video Display from the Edit menu or press x-C.

Copy Video Display command

A dialog box appears so you can specify where to save the
image. When you click Save, the image is saved as a PICT file
under the name that you supply. (A PICT file can be opened
by most graphics programs.)

If the video isn’t already frozen, it freezes at the current
frame until you complete the Save operation.

m To save the current video frame on a disk, click Save.

To unfreeze the video, click Freeze again.

The video freezes, and you can decide whether you want to
save the current frame.

m To freeze the video image at the current frame, click Freeze.

The Controls window can remain open without affecting
what happens in the video window.

3 Wait until you see the image you want to capture.
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The Controls window can remain open without affecting
what happens in the video window.

3 Wait until the sequence that you want to capture begins.

The capture controls appear.

2 Click the video camera icon.

The Controls window appears.

1 Choose Show Controls Window from the Windows menu.

To capture video images, follow these steps:

Video capture does not work as well with virtual memory
on. For best results, turn off virtual memory. To check
whether it is on or not, open the Memory control panel.
If the On button for virtual memory is selected, click the Off
button to turn virtual memory off.

You can capture video sequences (moving images) as
QuickTime movies.

Capturing movies

Capturing TV or Video Images
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You can open the movie from within any application that
supports QuickTime, such as SimpleText. (QuickTime is a
system software extension that comes with your computer.)

Use as small a size as you can: The amount of disk
storage that a movie takes is directly related to the size of
the video window—the larger the window, the more disk
space you use. By choosing Smallest Size from the Windows
menu before you record, you may be able to save more than
50 percent in storage space. (A movie that uses about
75 megabytes per minute at the normal video window size
will use only about 35 megabytes per minute at the smallest
video window size.) See “Changing the Video Window Size”
in Chapter 8.

You can also preview the QuickTime movie before you
save it.

A dialog box appears, in which you can specify a name and
location for your movie.

Important If you don’t click the Stop button, recording
continues until the hard disk is full.

5 Click Stop when you’ve recorded as much as you want.

Recording begins and the Record button changes to a Stop
button.

4 Click Record.
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Note

Compression affects picture quality: the more
compression you use, the grainier the picture.

Chapter 7

To save the most space you can, choose the smallest size
video window and the most compression.

None means that no compression takes place. Normal, the
preset choice, uses anywhere from 12 to 50 percent of the
disk space that None uses; the less movement in each frame
of the movie, the greater the savings. Most uses slightly less
disk space than does Normal.

2 Click one of the buttons under Movie Compression.

The Preferences dialog box appears.

1 Choose Preferences from the Setup menu.

With compression you can store movies in a much smaller
space than they would normally require. To use
compression, follow these steps before you record a movie:

Using compression
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Before following the instructions in this chapter you need to
open the Apple Video Player application by double-clicking
its icon. (The application is in the Apple Video Player folder,
in the Apple Extras folder on your hard disk.) You can also
press the TV/MAC button on the remote control.

m setting the video input standard (PAL, NTSC, or SECAM)

m changing the color of the windows

m changing the size of the video window

m viewing the Teletext window

This chapter gives instructions for using the following special
features of the Apple Video Player application program:

Other Features

C
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If Teletext information is not available, the Teletext window
will be empty, and a message will be displayed.

You can access the Teletext window for the current channel
by choosing Show Teletext Window from the Windows
menu, or pressing the x key plus the letter “T” on your
keyboard. You can close the Teletext window by choosing
Hide Teletext Window, pressing the x key plus the letter
“T,” or by clicking the Teletext window’s close box.

Some television channels offer a feature called Teletext that
displays information such as programming schedules, news,
or financial data. You can view both the Teletext window and
TV or video window at the same time. Different channels
may display different Teletext information, and some do not
display any Teletext information.

Viewing the Teletext window

Poor reception may result in missing characters in the
Teletext window.

Other Features
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m To view a subpage of the page you’re viewing, click the
Subpage pop-up menu and choose the subpage you want to
view. If this button is dimmed, there are no subpages.

m To return to pages you have already seen, click the Previous
button. This button moves you backward, up to twenty
pages. A dimmed Previous button means that there are no
more previous pages, or you have already seen twenty
previous pages.

Note

The Teletext window displays each page of
information as it is received by your TV tuner. To prevent the
current page from being updated, click the Hold button at
the bottom of the Teletext window. Click Hold again to
resume page updating.

m To return to the most recently viewed Index page, click the
Index button.

m To change pages, click the up or down arrow in the Teletext
window. Or, type the three-digit page number on your
keyboard. You can also double-click the three-digit page
number on the Teletext index page.

First choose Show Teletext Window from the Windows
menu. Then do the following:

Note

On some channels, the Index button changes to a
Table of Pages (TOP) button. See “Using TOP to Access
Teletext Pages,” later in this section.

You can read through the Teletext information by using the
page controls, the Index button, or the Previous button in
the Teletext window, or by using your keyboard.

Changing Teletext pages

Note
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To go the topic’s page: click on the topic or page number
in the Teletext window.

To display page numbers next to the topics: click on the
Reveal button.

To view the topics under headings in the TOP page: click
on the arrow beside a heading or subheading.

Some channels display a Table of Pages (TOP) page in place
of an Index page. TOP is a Teletext standard used in many
countries in Europe. When a channel broadcasts Table of
Pages data, a TOP button appears where the Index button
was. A TOP page groups subheadings under main headings.

Fastext is another way to quickly access Teletext pages
(This option may not be always available). Fastext is
controlled by colored buttons located above the Index,
Hold and Reveal buttons, labeled with corresponding
colored topics above them.

Click one of the colored Fastext buttons to move to the
related topic.

Using TOP to access Teletext pages

Using Fastext to access Teletext pages
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Copying a page to the Clipboard does not permanently save
the page. You must paste the Clipboard image into a
document or the Scrapbook to save the page for later use
or printing.

First choose Show Teletext Window from the Windows
menu. Then choose Copy Teletext Display from the Edit
menu. The current page is copied to the Clipboard.

You can copy the current Teletext page to the Clipboard,
and then paste it into a document for printing. Depending
on whether you use a word-processing or graphics program,
it will paste as a text or PICT file, respectively.

Printing the Teletext page

Note

When you click the Reveal button while Table of
Pages data is displayed in the Teletext window, page
numbers appear next to the topics in the window.

First choose Show Teletext Window from the Windows
menu. When you see a question in the Teletext window,
click the question, then click the Reveal button to see
the answer.

Sometimes the Teletext window displays questions or
riddles for you to answer. You can see the answers to these
questions by clicking the Reveal button at the bottom of the
Teletext window.

Revealing Teletext answers
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Keep your proportions: The usual video window width-toheight ratio is about 4 to 3. Setting other proportions
distorts the video image.

Width must be in the range 160 to 640 pixels. Height must
be in the range 120 to 480 pixels.

m Other Size opens a dialog box in which you can enter the
size you want.

On monitors that are 640 by 480 pixels or smaller, Largest
Size hides both the menu bar and the screen controls.
Moving the mouse makes the menu bar visible.

m Largest Size uses as much of the screen as it can.

m Normal Size uses about 1/4 of the screen.

m Smallest Size uses about 1/16 of the screen.

You can choose different video window sizes from the
Windows menu:

Choosing menu commands

There are several ways to change the size of the video
window. You can choose a command from the Windows
menu, use a keyboard shortcut for the three most common
sizes, click the zoom box, drag the size box, or use the
remote control. All but the last way are explained in this
section. The remote control is explained in Chapter 9.

Changing the video window size
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“Window Color” is not the display color: The Window
Color command has no effect on the colors you see in the
video window. For information on setting the brightness,
sharpness, and tint in the video window, see “Adjusting the
Picture” in Chapter 5.

You can set a new color for the border surrounding the
video window by choosing Window Color from the Windows
menu. The current color is checked. The choices are Dark
Gray, Green, Blue, Magenta, Red, and Gold.

Changing the window color

If you drag the size box while holding down the Shift key,
the image becomes distorted. (It stretches or shrinks in the
direction that you drag.)

If you drag the size box, the horizontal and vertical
dimensions of the screen change proportionally.

Dragging the size box

To alternate between the current size and the largest size,
click the zoom box.

m x-3 sets the largest size.

m x-2 sets normal size.

m x-1 sets the smallest size.

There are three keyboard shortcuts for changing the video
window size:

Using keyboard shortcuts and the zoom box

Other Features
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If the setting you choose produces a strange image (for
example, the picture is too small or the colors are odd), try
another setting.

2 Choose the Video Input Standard setting you need.

The Preferences dialog box appears.

1 Choose Preferences from the Setup menu.

To change the video input standard, follow these steps:

NTSC is the standard video signal for most of the Americas
and Japan. PAL is common in Western Europe, Australia,
most of Asia, and parts of South America and Africa. SECAM
is used in France, Eastern Europe, and parts of Asia and
Africa.

The video input standard determines how the Apple Video
Player application interprets video signals. This standard is
preset to your region in the Apple Video Player software. In
most cases, you won’t need to change it.

Setting the video input standard
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Before using the remote control, install the batteries that are
included in your package.

m move to the next track of an audio CD

m move to the previous track of an audio CD

m pause and continue play of an audio CD

m stop and eject a CD or CD-ROM disc

m control the sound from an audio CD

If your computer has a CD-ROM player, you can also use the
remote control to

m manipulate the size of the video window

m change TV channels or radio stations

m control the sound of the radio or TV

m switch from listening to radio to listening to a CD (if your
computer has a CD-ROM player)

m switch easily between watching TV or video, and using other
computer application programs

m turn the computer on and off

You can use your remote control to

Using the Remote Control

C

Cycles among
the six main
preset stations

Adjusts volume
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Note

Chapter 9

Your remote control may look different from the one
shown here, but it includes the same buttons.

Turns the
computer on
and off

Turns muting
on and off

Controlling your FM radio

Using the Remote Control
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If you are playing an audio CD in a CD-ROM drive, you hear
the audio CD and the TV or FM radio sounds simultaneously.

When you press the TV/MAC button while the radio is
playing, the Apple Video Player application starts, but you
won’t hear the TV or video until you quit the Apple FM Radio
application.

You cannot use the remote to switch to the Apple FM Radio
from another application. However, while you hear the radio
the FM radio remote controls will work.
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Note
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Your remote control may look different from the one
shown here, but it includes the same buttons.

Switches between
the video window
and computer
programs

Using the Remote Control

A99

Your remote control may look different from the one
shown here, but it includes the same buttons.

Goes to next
track on
audio CD

Goes to
previous track
on audio CD

Note

Plays/pauses CD

Turns the
computer on
and off

Stops/ejects CD

Adjusts volume

Changes
TV channels

Adjusts volume

Switches video
window between
current and
largest size

Turns muting
on and off

Turns the
computer on
and off

Controlling your CD-ROM player

Turns muting
on and off

Controlling TV or video
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The changes take effect immediately.

4 Click OK.

Chapter 9

If you no longer want to see the confirmation box, click the
checkbox to remove the X.

mind about shutting down the computer when you press
the remote control’s Power button, click the Confirm Power
Off checkbox to put an X in it.

3 To make a confirmation box appear so you can change your

If this checkbox is selected, the remote control won’t work.
To turn the remote control back on, click the checkbox to
remove the X.

Control checkbox to put an X in it.

2 To turn off the remote control, click the Disable Remote

The Preferences dialog box appears.

1 Choose Preferences from the Setup menu.

You can set these preferences for the remote control:
whether the remote control is on or off, and whether or not
a confirmation box appears when you press the remote
control’s Power button to shut down the computer.

Setting preferences
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If you attempt to repair the Apple equipment yourself,
any damage you may cause to the Apple equipment will
not be covered by the limited warranty on your Apple
equipment. Contact an Apple-authorized dealer or service
provider for additional information about this or any other
warranty question.

Warning

If you have a problem with your Apple
equipment and nothing presented in this chapter or in the
documentation that came with your computer solves it,
consult the service and support information that came with
your Apple equipment for instructions on how to contact an
Apple-authorized service provider or Apple for assistance.

This chapter suggests what to do if problems occur when
you’re using the Apple Video Player or FM Radio software.

Troubleshooting

C
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4 Double-click the Installer icon.

not already visible).
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3 Double-click the CD or disk icon to open it (if its window is

m If you purchased the Apple TV/FM Radio System kit
separately from your computer, insert the Apple TV/FM
Software Installation CD into the CD-ROM drive.

m If you purchased your computer with the TV/FM tuner
card already installed, locate either the system software
CD or the set of system software floppy disks (whichever
came with your computer). If you have a system software
CD, insert it into the CD-ROM drive. If you have a set of
system software floppy disks, insert the first disk (labeled
something like Install Disk 1 or System Backup Disk 1)
into the floppy disk drive.

application.

2 Insert the CD or disk that contains the Apple FM Radio

1 Start the computer.

You install Apple FM Radio from your system software CD,
system software disks, or the Apple TV/FM Software
Installation CD, depending on the disks or CDs you
received with your equipment.

If the Apple FM Radio application is not anywhere on your
hard disk, you need to install it.

You can’t find the Apple FM Radio application.

Problems listening to the radio

Troubleshooting
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m Be sure the volume on your computer is turned up. Use the
volume buttons on the front of your computer if you have
them, or use the sound-related control panel to adjust the
volume. (For more information on adjusting volume, see
Macintosh Guide if it is available on your computer or the
printed manuals that came with your computer.)

m The radio sound doesn’t work if Video or S-Video is selected
in the Apple Video Player application (even if that
application isn’t currently open). Open the Apple Video
Player application and choose Show Controls from the
Windows menu. Click the video screen icon (the second
button down on the left). Choose TV as your video source.
You can then quit the Apple Video Player application.
Now when you open the Apple FM Radio application, you
will hear radio.

m Be sure your FM antenna is securely connected to the FM
port (the left port) on the TV/FM tuner card and the antenna
is raised high. See the appropriate section in Chapter 1,
“Connecting Antennas, Cable, and Other Video Equipment.”

You don’t hear anything when you open the Apple
FM Radio application.

6 When installation is complete, click Restart.

The Apple FM Radio application is installed on your
hard disk (in the Apple FM Radio folder in the Apple
Extras folder).

m If you are installing from your system software CD or disks,
click Custom Install. Select Apple FM Radio from the
software list that appears, and then click Install.

m If you are installing from the Apple TV/FM Software
Installation CD, click Install and follow the instructions on
the screen.

5 Install the Apple FM Radio application.
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m The checkbox labeled Disable Remote Control may be
selected in the Preferences dialog box in your TV
application. Open Apple Video Player and choose
Preferences from the Setup menu. Deselect the Disable
Remote Control checkbox (click to remove the X).

m Try moving closer to your computer. If you are already very
close to the computer, point the remote control directly at
the remote control receiver on the front of the computer.

m Make sure the remote control has a battery, or try changing
the remote control’s battery.

The remote control doesn’t work.

m Adjust the FM antenna (connected to the left port on the
TV/FM tuner card). Be sure it is securely connected to the
port and raised high.

The reception is poor.

m You may need to broaden the signal range or strength. Make
sure the Apple FM Radio application is active. Open the
Options menu, choose Signal Range or Signal Strength, and
choose “DX” for Signal Range and “All Stations” or “All
Except Weakest” for Signal Strength. For instructions on
choosing a signal range or strength, see Chapter 3,
“Customizing the FM Radio Settings.”

Troubleshooting
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m If the Apple FM Radio is finding “fuzzy” stations when it
scans or adds stations, you may need to narrow the signal
range or strength. Make sure the Apple FM Radio is active.
Open the Options menu, choose Signal Range or Signal
Strength, and choose another setting. See what that does to
the Scan and Auto Add features. Experiment with different
settings to see which setting eliminates the stations you
don’t want. For instructions on choosing a signal range or
strength, see Chapter 3, “Customizing the FM Radio
Settings.”

m If the Apple FM Radio is finding too few clear stations, adjust
the FM antenna (the one connected to the left port on the
TV/FM tuner card) while the radio is playing to see if certain
stations come in clearer.

When you click Seek or Auto Add, the Apple FM
Radio finds either too few or too many stations.

m There isn’t a way to turn the radio on or off using the remote
control.

You can’t switch to radio using the remote
control, or quit the radio using the remote control.
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4 Double-click the Installer icon.

not already visible).
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3 Double-click the CD or disk icon to open it (if its window is

m If you purchased the Apple TV/FM Radio System kit
separately from your computer, insert the Apple TV/FM
Software Installation CD into the CD-ROM drive.

m If you purchased your computer with the TV/FM tuner card
already installed, locate either the system software CD, or
the set of system software floppy disks (whichever came with
your computer). If you have a system software CD, insert it
into the CD-ROM drive. If you have a set of system software
floppy disks, insert the first disk (labeled something like
Install Disk 1 or System Backup Disk 1) into the floppy disk
drive.

application.

2 Insert the CD or disk that contains the Apple Video Player

1 Start the computer.

You install Apple Video Player from your system software
CD, system software disks, or the Apple TV/FM Software
Installation CD, depending on what disks or CDs you
received with your equipment.

If the Apple Video Player application is not anywhere on
your hard disk, you need to install it.

You can’t find the Apple Video Player application

Problems watching TV or video

Troubleshooting
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m You may have left a dialog box open. Close any open dialog
box, then try the Power button again.

The Power button on your remote control doesn’t
work.

m You may not have selected TV as your video source. Choose
Show Controls Window from the Windows menu and click
the TV Video Source button.

You can’t switch to TV when you press the
TV/MAC button on the remote control.

m Try moving closer to your computer. If you are already very
close to the computer, point the remote control directly at
the remote control receiver on the front of the computer.

m Try changing the remote control’s battery.

m The checkbox labeled Disable Remote Control may be
selected in the Preferences dialog box. Choose Preferences
from the Setup menu and deselect this checkbox (click to
remove the X).

Your remote control doesn’t work.

6 When installation is complete, click Restart.

The Apple Video Player application is installed on your
hard disk (in the Apple Video Player folder in the Apple
Extras folder).

m If you are installing from your system software CD or disks,
click Custom Install. Select Apple Video Player from the
software list that appears, and then click Install.

m If you are installing from the Apple TV/FM Software
Installation CD, click Install and follow the instructions on
the screen.

5 Install the Apple Video Player application.
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m Reduce the number of colors or levels of gray your monitor
displays, using the control panel for monitors. (For more
information on adjusting a monitor, see Macintosh Guide if
it is available on your computer, or the print manuals that
came with your computer.)

You see a message that the built-in digitizer
cannot display video in the current monitor
setting.

m The video input standard is set incorrectly. Choose
Preferences from the Setup menu and select a different
setting.

The image is too small or it’s filled with odd
colors.

m Some static may result from poor reception over an antenna,
or from problems with cable service. Review the instructions
that came with your antenna or cable, or call the supplier for
assistance.

m You may have the wrong video source selected. Go to the
screen controls in the Controls window and click the
appropriate Video Source button.

m Be sure your antenna or cable service is securely connected
to the coaxial port on the TV tuner card.

m Be sure your video equipment is securely connected to
the appropriate video input port and your equipment is
turned on.

You see static or a blank screen when you try to
watch TV or video.

Troubleshooting
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m Some cable services use HRC cable frequencies instead of
standard cable frequencies. If you can’t receive channels
above channel 13, choose Channel Setup from the Setup
menu and select HRC Cable from the Connection pop-up
menu.

You have a cable service and you can’t see any
channels above channel 13.

m If you can switch between TV and computer using the
remote control, but have trouble switching using the
keyboard, check the hot key by choosing Hot Key from the
Setup menu. Be sure the key combination is not used by one
of your other programs. For instance, in most Macintosh
programs x-P sends a document to the printer. On the
desktop, x-N creates a new untitled folder.

Unexpected things happen when you try to switch
modes using a keyboard shortcut.

m Be sure the volume on your computer is turned up. Use the
volume buttons on the front of your computer if you have
them, or use the sound-related control panel to adjust the
volume. (For more information on adjusting volume, refer to
Macintosh Guide if it is available on your computer, or to the
print manuals that came with your computer.)

m Make sure you have quit the Apple FM Radio application. To
do so, click the FM Radio window to make it active, then
choose Quit from the File menu. (You can watch TV and
listen to the radio at the same time, but the radio sound
takes precedence.)

You don’t hear the TV, or you hear the radio
instead of the TV.
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m See “Forgetting a Password,” in the section “Creating and
Changing a Password” in Chapter 6 for instructions on
invalidating a forgotten password so that you can create
another password.

Your password doesn’t work, or you forgot your
password.

m The video window is too small or too large. Change the size
by making a choice from the Windows menu or by dragging
the size box.

You can’t see the volume slider on the video
window.

m If you had to reset your password because you forgot it, any
names you entered earlier for channels were erased. You
need to enter the names you want again. See “Giving Names
to Channels” in Chapter 6.

m You may have the wrong signal source selected. Each signal
source (antenna, or standard or HRC cable) has its own
channel list and potential list of channel names. Choose
Channel Setup from the Setup menu and make a different
choice from the Connection pop-up menu.

m You haven’t given a name to any channel. See “Giving Names
to Channels” in Chapter 6.

You can’t see the Names pop-up menu on the
video window.

Troubleshooting
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m If your computer is also connected to a secondary monitor,
make sure that your connection goes from the VCR to the
monitor, ending at the video input card. (The connection
must end at the video input card, not the secondary
monitor.) Also check that your secondary monitor is set to
loop-through (also known as “Hi-Z”) input.

m If you have a VCR connected to your video input card, make
sure you’re not having a problem with the videotape or the
VCR itself. (Connect the VCR back to your TV and play the
tape to see if the image is still bad.)

m Adjust the video screen controls. (Choose Show Controls
Window from the Windows menu and click the video screen
icon.)

You have a dark or “rolling” picture.

m The voltage output of your video equipment may be too
high or too low for the video input card. Therefore, your
video equipment may be sending video signals that are too
strong (causing a white picture) or too weak (causing a very
dark picture) for the video input card. Try connecting
different video equipment to the card.

m If you have a VCR connected to your video input card, make
sure you’re not having a problem with the videotape or the
VCR itself. (Connect the VCR back to your TV and play the
tape to see if the image is still bad.)

m Adjust the video screen controls. (Choose Show Controls
Window from the Windows menu and click the video screen
icon.)

The image is too white or too dark.
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m Turn up the volume controls on your video equipment.

m Adjust the sound controls in the Controls window. (Choose
Show Controls Window from the Windows menu and click
the sound icon.)

The sound is full of static.

m The voltage output of your video equipment may be too
high for the video input card. Therefore, your video
equipment may be sending signals that are too strong for the
video input card. Try connecting different video equipment
to the card.

m Turn down the volume controls on your video equipment.
They may be set too high for the video input card.

The sound is intermittent or clipped.
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remote control
batteries A95, A107
CD-ROM player A99
changing channels A57
changing volume A58
disabling A100
FM radio A96–A97
opening Apple Video
Player A46
problems with radio
A103–A104
problems with TV or
video A107
setting preferences A100
TV or video A98
removing TV channels from
list A52–A53
renaming TV channels
A64–A65
restricted access TV
channels A57
Reveal buttons (Fastext) A88
riddles, Teletext A90

Index

screen
blank A108
changing dimensions A92
controls A61
dark or rolling picture A111
static A108
service and support A101
setting preferences. See
preferences
Show Balloons (Guide [h]
menu) A23, A54
Show Controls window
A55–A56
Show Teletext Window
command (Windows
menu) A86
Shut Down command
(Special menu) A2, A6
signal
problems with A105
range A36
strength A37, A104
Simple Text application,
playing recordings
A39, A43
size box, dragging A92
slider, problems seeing A110
software
setting options after
reset A4
system A102
solutions to problems. See
troubleshooting
sound
adjusting A25–A26,
A58–A59
fading A53
muting A58
problems with A112
quality A41

A119

Table of Pages (TOP)
accessing Teletext
pages A89
changing Teletext
pages A87
technical support A101
Teletext
accessing on current TV
channel A86
changing pages A87
poor reception in
window A87
preventing updates A87
printing pages A90
questions and riddles A90

T

sound input ports, using RCA
plugs A16, A19
speaker balance and tone A60
static
radio A22
TV or video A108, A112
stations
changing with remote
control A96
presetting A28–A35
problems seeking A105
seeking A24–A25
stereophonic (stereo) sound
not available A67
selecting A26
Stop button A42
storage, conserving disk
space A40–A41, A83
support, technical A101
S-video input devices,
choosing to watch A56
S-video ports A13, A19
system software A102, A106

A120

using Fastext with A88
using Table of Pages
(TOP) to access
pages A89
viewing window A86–A90
television. See TV
time, resetting A4
TOP (Table of Pages)
accessing Teletext
pages A89
changing Teletext
pages A87
tower computers, attaching
antennas A9–A11
troubleshooting
listening to radio
A102–A105
watching TV or video
A106–A112
tuner card. See TV/FM
tuner card
tuning in
preset stations A28
seeking stations A24–A25
TV
attaching antenna
to compact computers
A2–A4
to modular computers
A6–A8
to tower computers
A9–A11
cable problems A109
installing application
software A106–A107
problems hearing A109
problems with remote
control A107
selecting as video source
A22, A56

Index

TV channels
adding to or editing list
A49–A51
changing A57, A98
fine tuning manually
A65–A66
locking and unlocking
A68–A69
naming A64–A65
password A70–A73
problems with list A110
remote control A98, A107
removing A52–A53
restricted access A57
setting for mono sound
A67–A68
using Apple Video Player
to tune A48–A49
TV/FM Software Installation
CD A102, A106–A107
TV/FM tuner card
attaching to compact
computer A2–A4
attaching to modular
computer A6–A8
attaching to tower
computer A9–A11
connecting video
equipment A12–A19
installing A1, A102–A103
TV/MAC button
on remote control
A46, A98
problems using A107
TV port
compact computers A3
modular computers A7
tower computers A10
TV program reminders
A74–A76

Index

VCR
connecting A12–A19
problems A111
video source A56
video
adjusting screen A61, A98
blank or static A108
capturing an image
A80–A81
capturing sequences
A82, A84
choosing source in Apple
Video Player A55–A56
copying images A81
installing software
application A106–A107
message to select TV A22
problems finding A106
problems with
images A111
problems with remote
control A107
video camera
connecting A12–A19
icon A80
video connectors
composite (RCA plug)
A14–A16
determining which to
use A13
S-video A17–A19
video equipment
connecting two pieces
A12

V

undoing changes A38

U
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connecting with RCA
plugs A14–A17
connecting with S-video
connectors and RCA
plugs A17–A19
voltage output A111
video input cards
composite video
connectors A14–A16
S-video connectors
A17–A19
video input port, using RCA
plugs A16
Video Input Standard
setting A93
video out ports, using RCA
plugs A16
video screen icon A55
video window
changing size using
keyboard shortcuts A92
changing size using menu
commands A91–A92
color of border A92
problems seeing
slider A110
problems with channel list
A110
switching to computer
programs A98
volume
adjusting on
computer A58
CD-ROM player A99
FM radio A25–A26, A96
TV A58–A59, A98, A109
volume slider, problems
seeing A110
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Y-adapter audio cable,
plugging in A15, A18

Y, Z

warranty A101

W, X
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PostScript, the LaserWriter page-description language, was developed by Adobe
Systems Incorporated.

Text type is Apple Garamond, Apple’s corporate font. Display type is Helvetica® Black.
Ornaments are custom symbols designed for Apple Computer.

This Apple manual was written, edited, and produced on a desktop publishing system
using Apple Macintosh computers and QuarkXPress. Technical illustrations were
drawn in Adobe™ Illustrator; screen shots were created and modified with system
software, ExposurePro, and Adobe Photoshop. Final pages were output using
PostScript™ technology.

The Apple Publishing System

Mention of third-party products is for informational purposes only and constitutes
neither an endorsement nor a recommendation. Apple assumes no responsibility with
regard to the performance or use of these products.

Simultaneously published in the United States and Canada.

Helvetica is a registered trademark of Linotype-Hell AG and/or its subsidiaries.

Adobe and PostScript are trademarks of Adobe Systems Incorporated or its subsidiaries
and may be registered in certain jurisdictions.

Apple, the Apple logo, LaserWriter, Macintosh, and QuickTime are trademarks of
Apple Computer, Inc., registered in the U.S. and other countries.

Apple Computer, Inc.
1 Infinite Loop
Cupertino, CA 95014-2084
408-996-1010
http://www.apple.com

Every effort has been made to ensure that the information in this manual is accurate.
Apple is not responsible for printing or clerical errors.

The Apple logo is a trademark of Apple Computer, Inc., registered in the U.S. and
other countries. Use of the “keyboard” Apple logo (Option-Shift-K) for commercial
purposes without the prior written consent of Apple may constitute trademark
infringement and unfair competition in violation of federal and state laws.

Under the copyright laws, this manual may not be copied, in whole or in part, without
the written consent of Apple. Your rights to the software are governed by the
accompanying software license agreement.

© 1997 Apple Computer, Inc. All rights reserved.
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Computer, Inc., could void the FCC Certification and negate your authority to operate
the product.

Important Changes or modifications to this product not authorized by Apple

If necessary, consult an Apple-authorized service provider or Apple. See the service
and support information that came with your Apple product. Or, consult an
experienced radio/television technician for additional suggestions.

m Plug the computer into an outlet that is on a different circuit from the television or
radio. (That is, make certain the computer and the television or radio are on circuits
controlled by different circuit breakers or fuses.)

m Move the computer farther away from the television or radio.

m Move the computer to one side or the other of the television or radio.

m Turn the television or radio antenna until the interference stops.

If your computer system does cause interference to radio or television reception, try to
correct the interference by using one or more of the following measures:

You can determine whether your computer system is causing interference by turning it
off. If the interference stops, it was probably caused by the computer or one of the
peripheral devices.

This equipment has been tested and found to comply with the limits for a Class B
digital device in accordance with the specifications in Part 15 of FCC rules. These
specifications are designed to provide reasonable protection against such interference
in a residential installation. However, there is no guarantee that interference will not
occur in a particular installation.

The equipment described in this manual generates, uses, and can radiate radiofrequency energy. If it is not installed and used properly—that is, in strict accordance
with Apple’s instructions—it may cause interference with radio and television
reception.

Radio and television interference

This equipment has been tested and found to comply with the limits for a Class B
digital device in accordance with the specifications in Part 15 of FCC rules. See
instructions if interference to radio or television reception is suspected.

FCC statement

Communications regulation information

v

Cet appareil numérique de la Class B respecte toutes les exigences du Règlement sur le
matériel brouilleur du Canada.

This Class B device meets all requirements of the Canadian interference-causing
equipment regulations.

Industry Canada statement

This product was tested for FCC compliance under conditions that included the use of
Apple peripheral devices and Apple shielded cables and connectors between system
components. It is important that you use Apple peripheral devices and shielded cables
and connectors between system components to reduce the possibility of causing
interference to radios, television sets, and other electronic devices. You can obtain
Apple peripheral devices and the proper shielded cables and connectors through an
Apple-authorized dealer. For non-Apple peripheral devices, contact the manufacturer
or dealer for assistance.
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Opening Apple Video Player A46
Setting up your TV channels A48
Getting help A53

5 Watching TV or Video A45

Compressing recordings A40
Saving recordings A42

4 Recording from the Radio A39

Presetting stations A28
Setting signal range and strength A36
Setting other preferences A37

3 Customizing the FM Radio Settings A27

Turning on the FM radio A22
Turning off the FM radio A23
Getting help A23
Tuning in to stations A24
Adjusting the sound A25

2 Listening to the FM Radio A21

Before you start A1
If you have a compact computer A2
If you have a modular computer A6
If you have a tower computer A9
Connecting other video equipment A12
Where to go from here A20

Ai

1 Connecting Antennas, Cable, and Other Video
Equipment A1

Preface Aiii

C

Aii

Index A113

Problems listening to the radio A102
Problems watching TV or video A106

10 Troubleshooting A101

Controlling your FM radio A96
Controlling TV or video A98
Controlling your CD-ROM player A99
Setting preferences A100

9 Using the Remote Control A95

Viewing the Teletext window A86
Changing the video window size A91
Changing the window color A92
Setting the video input standard A93

8 Other Features A85

Capturing individual images A80
Capturing movies A82

7 Capturing TV or Video Images A79

Giving names to channels A64
Fine tuning your channels A65
Setting channels to monophonic sound A67
Locking and unlocking channels A68
Creating and changing a password A70
Setting and editing TV reminders A74
Setting a hot key A77

6 Customizing the TV Tuner Settings A63

Using a hot key A55
Choosing a video source A55
Changing TV channels A57
Adjusting the sound A58
Adjusting the picture A61
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This manual tells you how to connect an FM antenna and TV
antenna (or cable service connection) to your card and how
to use the Apple FM Radio and Apple Video Player software.
It also explains how to connect other video equipment such
as a VCR.
Important If you purchased the computer with the TV/FM
tuner card already installed, you are ready to read the
information in this manual. If you purchased the Apple
TV/FM Radio System kit separately from your computer,
before you read this manual be sure to install the card
following the instructions in the Apple TV/FM Radio System
Installation Manual (in the other manual in your kit).

The TV/FM tuner card and software enable you to
m watch TV and video and listen to the radio on your computer
m view Teletext information
m capture video or TV images on disk
m save radio recordings on disk
m determine which channels or radio stations you receive
m set up a password to restrict access to one or more TV
channels
m manipulate basic TV and radio features with the included
remote control
m quickly switch among watching TV, listening to the radio,
and using your other computer application programs
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